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SAFETY WARNINGS 
To prevent fire or shock hazard, do not expose the DV-1 unit to 
rain or moisture. 

To avoid electrical shock, do not disassemble the DV-1 
enclosure or place any objects other than the DVD inside the 
system. Refer servicing to qualified personnel only. 

The use of optical instruments with the DV-1 product will 
increase eye hazard. As the laser beam used in the DVD drive 
is harmful to eyes, do not attempt to disassemble the DVD 
drive. Refer servicing to qualified personnel only.  

Should any solid object or liquid fall into the DV-1 unit, 
disconnect the unit from power and have it checked by qualified 
personnel before further operation.  
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1 Introduction 
1.1 WELCOME STATEMENT AND COMPANY VALUES 
Thank you for choosing the WatchGuard Video DV-1, the world's first 
in-car Direct-to-DVD Video system that records directly onto re-
writable DVD-Video discs that play in regular DVD players. The 
company was founded to bring the finest mobile law enforcement 
technology to the market. 

The WatchGuard DV-1 is the culmination of nearly 60 man-years of 
engineering development. This sophisticated system performs real-
time DVD-Video authoring in a mobile environment. The proprietary 
computing platform employs a dual-drive architecture and optical 
drive ruggedization techniques developed for U.S. fighter jets. No 
company in this industry has invested more engineering capital, or 
has been more aggressive in research and development than 
WatchGuard Video. With seven patents pending, the WatchGuard 
DV-1 represents the most advanced technology available in the 
industry. 

The management of WatchGuard Video places an emphasis on 
developing individual character qualities essential for true success, 
and the company is dedicated to maintaining a culture of service. Our 
management staff is encouraged to practice servant-based 
leadership within their groups with the knowledge that by serving 
God, people are empowered to better serve each other. This 
environment creates the framework for WatchGuard Video to 
ultimately serve our customers in a manner that instills the highest 
level of trust, confidence, and satisfaction. 
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1.2 ABOUT THE FLEET MANAGER UTILITY 
The Fleet Manager Utility is a Windows XP/Vista-based application 
used to create configuration files that can be burned to a CD. This 
CD can then be loaded into the DV-1, and all the settings in the 
configuration file can be loaded into one or multiple vehicles. Settings 
include Department Name, Officer Names, Vehicle ID’s, Pre- and 
Post-Event Times, etc. The Fleet Manager Utility is also capable of 
maintenance and diagnostics of the DV-1 through an Ethernet 
crossover cable connected to a PC. 

Saving multiple configuration files on a single CD simplifies the 
process of loading different configurations onto different vehicles. The 
configuration file name is usually the vehicle ID name. 

See Configuring DV-1s in a Fleet on page 15 for further details on the 
various strategies that can be utilized when deciding how to best 
configure a fleet of vehicles. 

 

1.3 NOTICES, CAUTIONS, AND WARNINGS 
 

NOTICE 
Notices provide useful supplemental information that is pertinent to 
the task being described. They may appear either before or after the 
text to which they apply.  

 

CAUTION! 
Cautions describe critical information that, if ignored, could result 
in damage to the DV-1, inoperability or degradation in function, or 
injury to personnel. Cautions always appear before the critical text 
to which they apply.  

 

WARNING! 
Warnings provide information pertaining to possible data loss.  
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1.4 USING THIS DOCUMENT 
This document is applicable to the Fleet Manager Utility (FMU) 3.5 for 
Windows XP Pro/Vista. 

This document covers the following topics: 
• Software Installation – Install the application on a PC 
• Configuring a Fleet of DV-1s – Manage the configuration of all 

DV-1 systems in a fleet of vehicles 
• Metadata Event Tags – Configure event tags for the DV-1 to 

prompt the in-car officer for answers to specific questions when 
ending a recording 

• Maintenance and Diagnostics – Extract data from the DV-1’s 
hard drive and perform basic diagnostics tests 

• Ethernet Connection to the DV-1 – Connect the FMU to a DV-1 
device via an Ethernet connection 

 

For other tasks not covered in this document, see Related 
Documents on page 8. 

The left side of each page usually contains: 
• Informational and procedural text 
• Graphical depictions of the buttons/menus used to perform 

procedures 
• Notices, cautions, or warnings 

The right side of each page usually contains the resulting screen, an 
error message, or a success message. Once familiar with the Fleet 
Manager Utility (FMU) application, many of the tasks can quickly be 
spotted by glancing down the left side of the document. 

 

1.5 PLEASE GIVE US YOUR SUGGESTIONS 
We want to hear from you. Tell us about your experiences with the 
DV-1 device and the Fleet Manager Utility (FMU) application. We will 
do our best to accommodate any suggestions you may have in future 
software revisions. 

U.S. customers, call Customer Service at 1-800-605-6734 or email us 
at support@watchguardvideo.com with your comments, questions, 
and concerns. International customers, contact your local distributor. 

 

mailto:support@watchguardvideo.com�
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1.6 SOFTWARE UPDATES 
We are committed to the continual testing and improvement of the 
Fleet Manager Utility software. Updates are provided to your agency 
for the life of the product, when available. 

 

1.7 MANUFACTURER CONTACT INFORMATION 
WatchGuard Video 
Attn: Customer Service Department 
3001 Summit Avenue 
Plano, Texas 75074 
1-800-605-6734 
support@watchguardvideo.com 

 

1.8 RELATED DOCUMENTS 
Refer to www.watchguardvideo.com/support/ for the following 
supporting documentation: 
• DV-1 User Manual 
• DV-1 Quick Reference Guide 
• Overhead System Installation Overview 
• Modular System Installation Overview 
• DV-1 Menu Navigation Guides (GUI) 
• DVD Manager Utility (DMU) Getting Started Guide 

 

 

 

mailto:support@watchguardvideo.com�
http://www.watchguardvideo.com/support/�
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2 Software Installation 
2.1 FLEET MANAGER UTILITY INSTALLATION  
Insert the Fleet Manager Utility CD into the in-car 
computer’s CD drive. If autoplay is turned on for 
the drive, the installation begins automatically. 

If autoplay is turned off for the CD drive, open the 
folder for the CD and click the setup.exe file to 
begin the installation process. 

 

The initial installation screen displays. 

Click Next to continue. 
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To change the default installation location, click 
Change… and select a different location. 

Click Next to continue.  

 

Click Install to install the application. 
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The installation continues. 

 

Click Finish to complete the installation. 
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2.2 LAUNCHING THE WATCHGUARD FLEET MANAGER 
UTILITY 

Once installation is complete, open the FMU 
application by launching the icon placed on the 
computer’s desktop. 

 

Alternatively, you may choose Start menu >  
All Programs > WatchGuard Video > Fleet 
Manager Utility. 

The Fleet Manager Utility opening screen 
displays. 

2.3 APPLICATION VERSION INFORMATION 
To determine the current FMU version, select 
Help > About… from the application’s main 
screen. 

Showing this detailed version information is of 
assistance when communicating with WatchGuard 
Customer Service and/or in determining when it is 
necessary to upgrade to newer versions of the 
FMU and the DV-1 system software. 
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3 Fleet Manager Utility Opening Screen 
3.1 CONFIGURATION 

 

Click the Configuration button on the opening 
screen to enter the configuration area of the FMU. 
From here, you can manage department settings, 
officer preferences, and vehicle settings for each 
DV-1 in the fleet. 

See Configuring DV-1s in a Fleet on page 15 for 
further details on the various strategies that can be 
utilized when deciding how to best configure a fleet 
of vehicles. 

 

3.2 MAINTENANCE AND DIAGNOSTICS 
A connection between the PC and the DV-1 device 
is required via an Ethernet connection in order to 
perform maintenance, run diagnostics tests, and/or 
extract diagnostics data from the DV-1. 

From the opening screen, click the Maintenance 
and Diagnostics button. See Maintenance and 
Diagnostics on page 56 for further details. 
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3.3 DV-1 CONNECTION SETTINGS 
The FMU can directly communicate with a DV-1 via 
a physical Ethernet cable that connects the 
Personal Computer (PC) to the DV-1. It can then 
send a configuration file to the DV-1 via this direct 
connection (bypassing the need to burn a CD).  

The FMU and DV-1 should already have the 
proper IP addresses for connectivity; therefore, in 
most cases, you need not change these values; 
however, if physically connecting to the DV-1 via 
an Ethernet connection, the DV-1’s IP address 
must be correctly set to successfully communicate 
through the Ethernet port. 

See Ethernet Connection to the DV-1 on page 63 
for detailed information on how to make this 
connection. 
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4 Configuring DV-1s in a Fleet 
4.1 DV-1 CONFIGURATION STRATEGIES 
What is the best strategy for configuring all of the 
DV-1s in a fleet of vehicles? This chapter is 
devoted to answering that question in order to 
choose the best Department strategy. 

The FMU has the ability to create one or more 
DV-1 configuration files. Think of these 
configuration files in much the same manner you 
might think of Microsoft Word documents or the 
individual files stored on the PC for an application 
like Microsoft Excel. There is one instance of the 
application installed; however, there can be many 
instances of the files created by the application. 

Analogous to the practice that Microsoft Word 
files are created with a .doc  or .docx file 
extension, WatchGuard configuration files are 
created with a .wgconfig file extension. 

 

The FMU can have more than one configuration 
file open at a time so that comparisons of the 
differences between each file can be made. Also, 
the application supports the ability to copy/paste 
settings between configuration files. See Copying 
Configuration Settings on page 38 for details. 

At this point, the question to answer is how many 
different DV-1 configurations are needed in order 
to manage all the DV-1s in your vehicle fleet. 

 

Departments with a small number of vehicles and 
officers might be able to manage their DV-1 fleet 
configuration with the use of a single 
configuration file, while large departments with 
many vehicles and officers serving different roles 
will need a strategy that includes the creation of 
one configuration file for each vehicle that 
contains a DV-1 system. 
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4.1.1 Simple Configurations for Small Departments 
In general, a small department can implement a 
single configuration file strategy if the following 
conditions are mostly true: 
• All officers driving DV-1 vehicles can operate 

any of the vehicles at any given time. (In 
other words, all officers rotate through any of 
the DV-1 vehicles.) 

• Department Default Preferences for all DV-1s 
in the fleet have the same property values for 
officer permissions, recording properties, 
recording triggers, vehicle device settings, 
etc. 

 

As the number of DV-1s and the number of 
officers serving different roles increases, it is 
likely that a single configuration file strategy is 
not the right answer. 

A single configuration file can be deployed to all DV-1s 
in the fleet if all vehicles and all officers in those vehicles 

require the same settings. 

 

4.1.2 More Complex Configurations for Larger Departments 
If the vehicles/officers require different settings, 
then a single configuration file strategy won’t 
work. Multiple configuration files may need to be 
created and managed. In the most complicated 
of cases, a unique configuration file can be 
created for each DV-1 vehicle in the fleet. 

 

This strategy supports complete flexibility in 
allowing each vehicle to have a unique set of 
Officer Preferences and Department Default 
Preferences for each DV-1 in the fleet. This 
allows the same named officer to optionally have 
different settings for each vehicle since an officer 
might fill different roles based on what vehicle 
he/she is in at the time. Likewise, each vehicle in 
the fleet might have different input devices (e.g., 
radar, GPS, etc.) needing their own unique 
configuration. 

Multiple configuration files can be deployed to each DV-1 in 
the fleet when the officers/vehicles require unique settings. 
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An option to help make complicated cases easier 
is to create a single configuration file which 
serves as a Master Template Configuration File. 
Use this template file to store some of the most 
common Officer and Department settings, and 
then use this file as a basis for newly created 
configuration files. In this case, a strategy might 
be to have one Master Template Configuration 
File and one configuration file for each DV-1 
vehicle in the fleet. 

See Using a Master Template Configuration File 
on page 37 for further details on using a template 
file. 

One file for each vehicle and one master template file 

 

4.2 ‘GETTING STARTED’ CONFIGURATION WIZARD 

If it is the very first time to run the FMU 
application, the ‘Getting Started’ Configuration 
Wizard launches to create the first configuration 
file. This wizard assists with configuring the most 
commonly used configuration settings. 

NOTICE 
The default name for the first configuration file 
created is VehicleConfig1.wgconfig. 
Configuration files can be named anything, as 
long as the .wgconfig file extension is 
preserved.  
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4.2.1 ‘Getting Started’ Wizard – Department Name/Time Zone 

Follow the prompts on each step of the wizard, 
clicking Next to proceed to subsequent steps 
and Back to navigate backwards. To skip the 
wizard altogether, click the Close button. 

Enter the Department/Agency Name in the 
text box. This is the name that appears as 
caption text on the DV-1 screen and also in the 
menu title of DVDs created by the DV-1. 

Select the Time Zone from the drop-down list. 

Click Next to continue. 
 

4.2.2 ‘Getting Started’ Wizard – Vehicle Identifier 
Enter a Vehicle ID to identify the vehicle for 
which the configuration file is to be used. 

If the configuration file will be used for any of the 
following purposes, it is recommended that the 
Vehicle ID field remain blank: 
• The configuration file will be used as a 

Master Template Configuration File from 
which all other vehicle’s configuration files 
will originate 

• There is more than one DV-1 vehicle in the 
fleet, but only one configuration file will be 
used for all DV-1 vehicles. (In this case, set 
the Vehicle ID for each DV-1 manually after 
deploying the configuration file to each  
DV-1.) 

Click Next to continue. 
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4.2.3 ‘Getting Started’ Wizard – Video Quality Mode 

The factory default setting for Video Quality 
Mode is 4 Hours – Normal. To change this 
setting, click the Edit Video Quality button 
and modify as desired. 

Click Next to continue. 

 

4.2.4 ‘Getting Started’ Wizard – Officer List 

Click the New Officer button. 
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The Create Officer screen displays. 

Enter the officer’s name (maximum characters is 
23). If the officer’s rank or title is desired, enter 
that in the field as well. 

To give the officer Supervisor permission, check 
the Officer serves as a supervisor 
checkbox. 

Enter a Supervisor PIN number (must be 5 
numeric characters), and re-type it in the second 
PIN field. 

Click Save to add the new officer name. 

Repeat these steps for each officer and click the 
Next button to continue. 

 

An officer with Supervisor permission can 
perform the following tasks: 
• Add or delete users 
• Determine operational parameters of the  

DV-1 (e.g., start/stop triggers, default user 
settings, etc.) 

• Set Department Name 
• Configure pre-/post-event times 
• Choose video quality 
• Determine which on-screen text is recorded 

to the DVD 
• Configure input devices 
• Update firmware 
• Format the hard drive 
• Burn backup DVDs 

See the DV-1 User Manual for further details on 
functionality that is reserved for officers 
designated as Supervisors. 

 

4.2.5 ‘Getting Started’ Wizard – Completion 
Once you reach Step 5 in the wizard, you have 
edited the most common configuration settings 
for the configuration file that you are currently 
creating. 
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You may now take one of the following actions: 
• Send to CD – To deploy this configuration 

file to DV-1s in the fleet, burn this file to CD 
and insert the CD into one or more DV-1 
devices. (Note that you can burn multiple 
configuration files to the same CD and use a 
single CD to configure multiple DV-1 
devices.) 

• I’m not ready to create a CD. I want to 
close this window & edit additional 
configuration settings – Click the close 
this window… link or the Finished 
button to close the dialog box and return to 
the main screen to continue editing. 

 

4.2.6 Send to CD 
To burn the file to CD, click the Send to CD 
button in Step 5 of the wizard.  

The Review and Confirm screen displays, 
showing a brief summary of the configuration 
settings, serving as a quick sanity check before 
sending the configuration to CD.  

In the frame labeled Officer Preferences vs. 
Department Default Preferences 
Mismatch, a comparison of the Department 
Default Preferences and the Officer Preferences 
is shown. There are two supervisors and seven 
non-Supervisors defined in our example 
configuration file. 

If internal department requirements dictate that 
all Officer Preferences must match the 
Department Default Preferences, then this is the 
step in the process to check for adherence to 
such a policy. 

 

The numeric figures displayed in red and 
highlighted with the  icon indicate how many 
officers have preferences that do not match the 
current Department Default Preferences. View 
which officers are mismatches by clicking the 
Show mismatch comparisons button. 
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To force all Officer Preferences to be equal to the 
current Department Default Preferences, click the 
Reset all officer preferences to 
department default preferences button.   

Alternatively, click the Reset Officer 
Preferences button on the main screen’s 
toolbar to overwrite all Officer Preferences at any 
time. 

 

Click Yes at the confirmation screen to overwrite 
all officer preference settings, or No to return to 
the previous screen. 

 

To burn the configuration file to CD, click the 
Continue button on the Review and Confirm 
screen. 

The Burn configuration file to CD-ROM screen 
displays, allowing a choice of two options: 
• Option A – Use Windows CD Writing Wizard 
• Option B – Use a CD burning application 

(e.g., Nero) 

 

4.2.6.1 Option A: Use Windows CD Writing Wizard 

The Windows CD Writing Wizard is a part of the 
Windows operating system. To run this wizard, 
click the use the Windows CD Writing 
Wizard link. 
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The Windows CD Writing Wizard screen 
displays. 

Click Continue to copy the configuration file 
into the directory containing files destined to be 
written to CD. 

 

Depending upon the Windows version, this action 
may cause a notice to appear in the Windows 
system tray. Click the yellow balloon to see the 
files waiting to be written to the CD. 
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The FMU automatically opens a new instance of 
Windows Explorer showing the Files Ready to 
Be Written to the CD list for the computer’s 
CD drive. 

When ready to burn the file to CD, select File > 
Write these files to CD. 

 

Windows Explorer launches the Windows CD 
Writing Wizard. 

Follow the prompts to write the configuration file 
to the root folder of the CD. 
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4.2.6.2 Option B: Use Your Favorite CD Burning Application 

The full path location for the configuration file on 
the computer’s hard drive is shown. Click the 
Browse to folder in Windows Explorer 
link to open Windows Explorer in the parent 
folder of the file to easily copy/paste or drag/drop 
the file into the desired CD burning application. 

Once the configuration file is burned to the root 
folder of a CD, deploy the configuration by 
inserting the CD into one or more applicable  
DV-1s in the fleet. 

 

4.3 IMPORTING CONFIGURATION FILES INTO THE DV-1

Once the configuration file(s) exist on the CD 
(regardless of the burn method used), insert it 
into the DV-1.  

The DV-1 automatically displays a list of 
configuration files on the CD, allowing the 
operator to choose which configuration file to 
import to the DV-1. 

Press the Up  & Down  keys to select the 
configuration file to import to the DV-1, and then 
press Select. 
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If one or more Supervisor officers is already 
configured on the target DV-1 (regardless of 
whether or not any Supervisors are defined in the 
configuration file being imported to the DV-1), the 
officer is prompted to enter a Supervisor PIN. A 
valid Supervisor PIN must be entered before the 
configuration file is allowed to be imported by the 
DV-1, and the PIN that is entered must be a PIN 
that existed previously on the DV-1.  

If no Supervisor PINs exist on the DV-1 at the 
time that the configuration file is imported, then 
the Administrator PIN must be entered instead. 

Press the  and  keys to navigate to the 
correct number, and then press Enter to select 
each number. If you enter an incorrect number, 
Invalid PIN is displayed and you must start over 
again. 

Press Cancel before the fifth number is entered 
to exit without logging in. The Login key is 
automatically pressed when the fifth number is 
selected. 

 

The LOAD CONFIGURATION screen displays, 
and the settings from the configuration file load to 
the DV-1. 

NOTICE 
Time Saver Tip – Multiple Files on a Single 
Configuration CD: More than one configuration 
file can exist at the root folder of the CD. 
Burning multiple configuration files to the same 
CD is a flexible solution that can save time. That 
single CD can then be transported to all 
applicable vehicles, and the appropriate 
configuration file can be imported to each 
vehicle.  
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4.4 EDITING ADDITIONAL CONFIGURATION SETTINGS 
The ‘Getting Started’ Configuration Wizard 
discussed on page 17 assists in editing only the 
most common configuration settings. This section 
describes a high-level view of all configuration 
settings and how to edit them. 

For a list of all factory default settings, see the 
tables in Factory Default Settings starting on 
page 32. 

 

 

The pane on the left shows a hierarchical tree 
view of all configuration categories. Selecting a 
category or item in the left pane causes the 
appropriate information to display in the right 
pane. The Department Name and Time 
Zone settings are shown in the right pane since 
the Department category in the left pane is 
selected. 
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4.4.1 Department Policies 
Department Policies are set once globally for the 
vehicle within a given configuration file. They 
include settings for such things as video quality, 
start triggers, microphone behavior, and 
permissions, to name a few. 

Officers do not have settings for Department 
Policies. To set individual Officer Preferences, 
see Department Default and Officer Preferences 
on page 29 

 

In the left pane, expand the  Department 
item and select  Policies.  

The right pane displays policy settings for such 
things as  Video Quality,  Pre-Event Time 
Added to DVD Prior to Record, Auto-Record 
Start Triggers, etc.  
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Double-clicking a property in the right pane will, 
in many cases, bring up an editor dialog for that 
property; however, if double-clicking on a 
property containing only Yes/No values, the 
value is simply changed to the opposite value.  

For example, double-click the Video Quality 
property. 

 

The Video Quality editor dialog displays. Use 
the mouse to select one of the property values 
from the list on the left side. Note that the right 
side shows a detailed description of the given 
property. 

The  indicates the factory default setting for 
the given property. 

The  icon indicates the current Department 
setting for the given property. 

Click the Save button to save the changes, or 
Cancel to exit without saving changes. 

4.4.2 Department Default and Officer Preferences 
Each officer can have their own unique set of 
preferences that differ from the Department 
Default Preferences. When an officer name is 
added, a  Preferences icon is created beneath 
the new officer name, indicating that each officer 
can have their own set of preferences. Anytime a 
new officer name is added to the configuration 
file, the new officer automatically inherits the 
Department Default Preferences as his or her 
own settings. The Officer Preferences remain the 
same as the Department Default Preferences 
unless changed. 

First, ensure that the officer name is created as 
described in ‘Getting Started’ Configuration 
Wizard on page 17, and then select the 

 Preferences icon beneath the officer’s 
name.  
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When the  Preferences item is selected under 
an  officer name, the same list of properties 
appears in the right pane as did appear when 
selecting the Department Default Preferences 
option. 

Changing a property value for a given officer 
does not change the same property value in the 
Department Default Preferences (and vice-
versa). 

To give one or more officers the same setting for 
a particular property, one easy solution is to first 
change the Department value for that property 
and then drag/drop the property from the 
Department’s right pane onto the  Officer List 
(to apply to all officers), or onto a single  
officer name in the left pane. 

See Copying Configuration Settings on page 38 
for further details on copying Department settings 
to one or more officers. 

 

4.4.3 Vehicle Settings 
Select the  Vehicle icon in the left pane to 
display the Vehicle Settings on the right. 

The first property displayed in the right pane is 
Vehicle ID, previously addressed in the 
‘Getting Started’ Configuration Wizard on page 
17. If the configuration file will be used for any of 
the following purposes, it is recommended that 
the Vehicle ID field remain blank: 
• The configuration file will be used as a 

Master Template Configuration File from 
which all other vehicle’s configuration files 
will originate 

• There is more than one DV-1 vehicle in the 
fleet, but only one configuration file will be 
used for all DV-1 vehicles. (In this case, set 
the Vehicle ID for each DV-1 manually after 
deploying the configuration file to each  
DV-1.)  
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For vehicle settings, the list on the right also 
includes the properties that manage the various 
input devices to the DV-1, e.g., emergency siren 
and brake light monitoring, radar systems, and 
GPS. Double-click on any of these list items to 
edit them or to learn more about the values 
available for each property. 

There is only one instance of each vehicle setting 
in a given configuration file. Thus, an individual 
officer cannot have his or her own set of vehicle 
preferences. 
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4.5 FACTORY DEFAULT SETTINGS 
The following tables show the Factory Default 
Settings from the Fleet Manager Utility.  

Table 1 Department Default Preferences 

Property Value Description 

Wireless Microphone Volume 0 – OFF Volume level when listening to live audio from wireless microphone 
when DV-1 is recording 

Playback Cabin Volume 5 Playback volume level of cabin microphone when reviewing video on 
DV-1 

Playback Wireless Microphone Volume 8 Playback volume level of wireless microphone when reviewing video 
on DV-1 

DV-1 LED Panel Brightness 10 – MAX Brightness level for the DV-1's backlit LED front panel buttons 

DV-1 Screen Display (LCD) Brightness 5 Brightness level for the DV-1's LCD front panel screen 

Microphone Setting All Microphones 
Off 

Determines which microphones are turned on 

Forward Camera – Night View Mode Auto Increases overall light sensitivity at night 

Forward Camera – Backlight 
Compensation Mode 

No Brightens overall exposure when a subject in foreground would 
otherwise appear dark due to strong backlighting 

Forward Camera – Auto Zoom Hold 
Time 

Hold tight zoom 
for 5 seconds 

Amount of time for camera to stay in the tight zoom position when 
auto-zooming 

Forward Camera – Auto Zoom 
Magnification Level 

5 X Magnification Zoom level for camera when auto-zooming 

Forward Camera – Initial Zoom 
Magnification Level 1 X Magnification Initial zoom level for camera on system startup 

Rear Camera – Night View Mode Off Increases overall light sensitivity at night 

Rear Camera - Backlight 
Compensation Mode 

No Brightens overall exposure when a subject in foreground would 
otherwise appear dark due to strong backlighting 

Split Screen Display Settings Forward Camera 
only 

Select which camera feeds appear on the screen and also what video 
data is recorded to DVD video discs. 

Screen Saver Wait Time 1 minute Specifies how much idle time must elapse before the screen saver 
activates. 

Screen Saver Exit On Record Start True Immediately exit screen saver mode when a recording begins. 

Screen Saver Active While Recording False Can the system enter screen saver while a recording is active. 
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Table 2 Department Default Policies 

Property Value Description 

Video Quality 4 Hours - Normal Choose a quality/resolution setting for video that is recorded 
to DVD 

Number of DVD Backups to keep on 
DV-1 

4 Identifies the number of DVD archive backups to keep on the 
DV-1's hard disk for burning duplicate DVDs after the fact 

Pre-Event Time Added to DVD Prior to 
Record 

2 Minutes Add up to 10 minutes of previous video footage before a 
recorded event 

Post-Event Time Added to DVD After 
Recording 

None Automatically add up to 10 minutes of post video footage 
after a recorded event 

Automatically Turn DV-1 On When 
Vehicle Is On 

Yes Automatically power on the DV-1 when the vehicle is turned 
on 

Automatically Turn DV-1 Off When 
Vehicle Is Turned Off 

Yes Automatically power off the DV-1 when vehicle is turned off 

Allow DV-1 To Be Powered Off When 
Vehicle Is On 

Yes Allow officer to shut down the DV-1 while vehicle is on 

Automatically Turn On Both 
Microphones When Record Begins 

Yes (1st and 2nd Generation DV-1) Automatically switches the 
wireless microphone on when the DV-1 begins recording 

Allow Officers to Turn Off Microphones 
While Recording 

Yes (1st and 2nd Generation DV-1) Allow officer to turn off 
microphones while recording 

Allow Officers to Turn Off Wireless 
Microphone While Recording 

Yes (3rd Generation DV-1) Allow officer to turn off wireless 
microphone while recording 

Allow Officers to Turn Off Cabin 
Microphone While Recording 

Yes (3rd Generation DV-1) Allow officer to turn off cabin 
microphone while recording 

Allow Officers to Turn On Wireless 
Microphone When Record Begins 

Yes (3rd Generation DV-1)Allow officer to turn on wireless 
microphone while recording 

Allow Officers to Turn On Cabin 
Microphone While Recording 

Yes (3rd Generation DV-1) Allow officer to turn on cabin 
microphone while recording 

Force Cabin Microphone On Even 
When Not Recording 

No Always force cabin microphone on even when not recording 

Charge Wireless Microphone While 
System Off 

Yes Charge the wireless microphone while the system is turned 
off. 

Allow Officers to Add/Delete/Edit Officer 
Names 

Yes Allow officer to add, delete, and edit any officer name 
information 

Allow Officers to Edit Auto-Record 
Start/Stop Triggers 

No Allow officer to select which triggers will activate and/or end 
a recording 

Allow Officers to Edit Camera Auto 
Zoom 

Yes Allow officer to change the auto-zoom sequence settings 
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Property Value Description 

Allow Officers to Edit Which Text Fields 
Are Recorded 

No Allow officer to select which on-screen text fields will be 
included in a recording 

Allow Officers to Edit DV-1 Date and 
Time 

Yes Allow officer to set/edit the date and time on the DV-1 

Allow Officers to Edit Vehicle ID Yes Allow officer to add/edit the vehicle identification number 

Allow Officers to Edit Video Quality No Allow officer to set the level of DVD video quality for the 
recording 

Allow Officers to Edit Input Devices No Allow officer to adjust settings for input devices 

Allow Officers to Edit Pre/Post Event 
Recording Times 

No Allow officer to select times for Pre and Post Event recording 
settings 

Allow Officers to Edit Department Name No Allow officer to enter/edit the department name 

Allow Officers to Reuse DVD Discs 
Without Entering Supervisor Password 

No Allow officer to reuse a DVD disc without supplying a 
supervisor password 

Allow Officers to Burn Archive Copy of 
DVD Without Entering Supervisor 
Password 

No Allow officer to burn an archive copy of a DVD without 
supplying a supervisor password 

Close the current DVD on eject No Close the current DVD on eject 

Video Review Access Levels Officer, Officer, Officer, 
Officer 

Access levels required to review video 

Auto-Record On Emergency Lights 
Activation 

Yes Start recording automatically when the emergency lights are 
activated 

Auto-Record On Auxiliary Input 
Activation 

No Start recording automatically when the auxiliary device is 
activated 

Auto-Record On Emergency Siren 
Activation 

Yes Start recording automatically when the emergency siren is 
activated 

Auto-Record On Crash Detection Yes Start recording automatically when a patrol vehicle crash is 
detected. (May not be available on all DV-1 systems.) 

Auto-Record On Wireless Microphone 
Activation 

Yes Start recording automatically when the wireless microphone 
is activated 

Metadata Event Tags No tags defined Defines extra metadata tags that can be added to a record 
event by the in-car officer for a given traffic stop. 

Auto-Record Stop Trigger 5 minutes - Stop when 
start triggers inactive for 5 
minutes 

Stop recording automatically after a given period of inactive 
time transpires 

Auto-Record Stop Trigger Confirmation 
Prompt 

Yes Confirm before automatically stopping during a record event 
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Property Value Description 

DV-1 Screen - Display Text Fields 
Master Switch 

Yes Global DV-1 setting that determines whether to display on-
screen text on the DV-1 screen but has no impact on what is 
recorded to DVD 

DV-1 Screen - Display Disc Usage Yes Determines whether the DVD disc usage bar is displayed on 
the DV-1 screen 

Record to DVD - Auxiliary Status No Determines whether input from auxiliary device is recorded 
to DVD 

Record to DVD - Officer Name Yes Determines whether selected officer name is recorded to 
DVD 

Record to DVD - Patrol Vehicle ID Yes Determines whether vehicle ID is recorded to DVD 

Record to DVD - Time and Date Yes Determines whether time/date is recorded to DVD 

Record to DVD - Crash Detection Yes Determines whether crash detection is recorded to DVD 

Record to DVD - Brakes Status Yes Determines whether input from brakes is recorded to DVD 

Record to DVD - Department Name Yes Determines whether department name is recorded to DVD 

Record to DVD - Lights and Siren 
Status 

Yes Determines whether input from lights and siren is recorded to 
DVD 

Record to DVD - GPS Coords No Determines whether GPS coordinates are recorded to DVD 

Record to DVD - Radar Speeds No Determines whether radar speeds are recorded to DVD 

Table 3 Vehicle Default Preferences 

Property Value Description 

Vehicle ID  Unique text identifier for the vehicle 

Vehicle Speed Units MPH (miles per 
hour) 

Vehicle speed sensor speed display units 

Temperature Display Units Fahrenheit Choose the preferred setting for how temperature is displayed. 

Fan Speed Offset 0 Choose the preferred setting for the relative fan speed offset. The larger the value, 
the faster the fan speed. 

Emergency Siren Yes Monitor input from the emergency siren 

Emergency Lights Yes Monitor input from the emergency lights 

Brakes Yes Monitor input from the vehicle brakes 

Auxiliary Input No Monitor input from the auxiliary input device 
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Property Value Description 

Crash Sensitivity Medium If applicable for your hardware, select the crash sensitivity setting for the DV-1. 

Global Positioning System 
(GPS) Type 

None If applicable for your hardware, select the type of global positioning system (GPS) 
for the DV-1. 

Display GPS Speed Yes Determines whether GPS speed is displayed 

Radar Type None Optionally choose the type of radar used by the system 

Radar Display Fast Lock 
Speeds 

Yes Determines whether speed of fastest vehicle in a group of cars is displayed and 
whether the locked vehicle speed of the radar is displayed 

Radar Display Patrol 
Speed 

Yes Determines whether speed of patrol vehicle is displayed 

Radar Display Target 
Speeds 

Yes Determines whether speed of target vehicles is displayed 

 

4.6 CREATING AND OPENING MULTIPLE 
CONFIGURATION FILES  

The FMU can create and manage more than one 
configuration file at a time, allowing settings from 
one file to be copied to another. 

Select File > New Configuration File to 
create multiple files one at a time. The default 
filename, VehicleConfig1.wgconfig is 
incremented by one each time this option is 
selected. 

 

Select File > Open to open multiple 
configuration files. 
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To switch between the open files, select the 
Windows menu on the main screen and select 
the desired file. 

 

4.7 USING A MASTER TEMPLATE CONFIGURATION 
FILE 

If most or all of the fleet’s DV-1 devices have 
many of the same settings, create and maintain a 
Master Template Configuration File. Use this 
template file to store some of the most common 
Officer and Department settings, and then use 
this file as a basis for newly created configuration 
files. See DV-1 Configuration Strategies on page 
15 for help in deciding the best strategy for your 
Department. 

For example, when a new vehicle is outfitted with 
a DV-1 system, make a copy of the template file, 
rename it appropriately for the new vehicle, and 
customize properties that are specific to the new 
vehicle. To deploy the configuration file to the 
new vehicles’s DV-1, open the new file as well as 
the template file, and then copy/paste (or 
drag/drop) the applicable settings from the 
template file to the new file. This ensures that the 
new file is synchronized with the standard Officer 
and Department settings as configured in the 
template file. 

See Copying Configuration Settings on page 38 
for details on copying settings within the same or 
different configuration files. 
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4.7.1 Copying Configuration Settings 
Officer Preferences and Department Default 
Preferences can be copied from one configuration 
file to another by using either the copy/paste or 
the drag/drop method. Each configuration file is 
independent of the content in any other file. It is 
important to keep the files synchronized if they 
are to contain matching configuration settings. 

 

4.7.1.1 Copy Officer List to New Configuration File 

In this example, we use the copy/paste method to 
copy the entire  Officer List from the 
VehicleConfig3.wgconfig (source) file to the 
VehicleConfig1.wgconfig (destination) file.  

First, ensure that both the source and destination 
files are open. Highlight the  Officer List item in 
the VehicleConfig3.wgconfig (source) file, 
and select Edit > Copy. Alternatively, right-click 
the  Officer List item and select Copy. 

 

From the VehicleConfig1.wgconfig 
(destination) file, select Edit > Paste Officer 
List. (The Paste option displays the number of 
officers being copied as well as the name of the 
source file.) 

The VehicleConfig1.wgconfig (destination) 
file now contains the same Officer List as the 
source file.  

To achieve the same results using the drag/drop 
method, simply drag the  Officer List from the 
source file into the destination file.  
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4.7.1.2 Copy Department Preferences to One or More Officers 

In addition, one or more properties can be copied 
and pasted to the entire  Officer List or to a 
single  officer name. 

For example, to copy the Department’s volume 
preferences to one or more of the officers, first 
select the Department Default Preferences. 

 

From the right pane, select the desired properties 
(hold down the Ctrl key on the keyboard to select 
multiple). 

 

Select Edit > Copy (or right-click within the 
selection area and select Copy). 

 

or

  

To paste to a single officer, right-click the officer 
name and select Paste. 
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A check appears to the left of the desired officer 
name. At this time, additional officer names may 
be selected, or simply click Apply to apply the 
settings to the selected officer. 

The selected officer has now inherited the 3 
Department Default Preferences for volume 
control. 

NOTICE 
If using the Select All option, the checkbox for 
Department Default Preferences is automatically 
selected, and the Department’s settings will be 
overwritten.  
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5 Metadata Event Tags 
5.1 EVENT TAG DEFINITION 
Event tags are defined in the FMU and loaded into 
the DV-1 on a configuration CD. When a DV-1 
recording is ended, the in-car officer is prompted to 
provide additional details of the event that just 
occurred. Some examples of event tags are Event 
Category, Ticket Number, Is the event critical 
evidence?, License Plate Number, etc. 

There are 2 types of event tags: 
• Dropdown List – The in-car officer selects from 

a list of answers when prompted with a question. 
• Text Field – The in-car officer enters the answer 

in a text box; can be restricted to alphanumeric or 
numeric characters. 

Event tags can be configured as follows: 
• Required – Must enter an answer to continue 
• Optional – Answer is not required; the in-car 

officer can either manually skip these, or the 
screen automatically advances if the event tag 
has a timeout configured. 

• Hidden – Creates a non-editable default event 
tag that is never displayed to the in-car officer on 
the screen, but it is written to the DVD for each 
recording. This option is only available for Text 
Field event tags. 

 

5.2 SPECIAL SCREEN ICONS 
The following is a list of some of the icons you may 
encounter as you are entering and editing event tags:  

Print icon – Opens a page in your default browser, 
enabling you to print a list of either the available or 
the configured event tags  

DV-1 View icon – Displays a representation of what 
the resulting screen will look like on the DV-1 with the 
configured event tag  
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Add Wizard icon – Runs the Add Wizard 
 

Edit Wizard icon – Runs the Edit Wizard 
 

Info icon – Displays help on a specific field or option 
 

Event Tag Order – Use the blue arrows to change 
the order of created event tags. See Changing the 
Order of Event Tags on page 53 for further details. 

 

Field name in use icon – Shows you which 
metadata event tags you have already selected for 
the current configuration file  

5.3 EVENT TAGS MAIN SCREEN 
From the main screen, click the Metadata Event 
Tags button from the toolbar at the top.  

The Metadata Event Tags screen displays. 
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5.4 ADDING EVENT TAGS 
When adding event tags, you have the choice of 
using either the Wizard or the Editor. The Editor 
allows you to create the tags from scratch, whereas 
the Wizard has built-in prompts and answers for 
commonly used event tags. 

 

From the Event Tags Main Screen shown on page 
42, add an event tag using the Editor by clicking 
either the Editor link in the What would you like 
to do? section or the Add button at the top. 

 

or 

 

From the Event Tags Main Screen shown on page 
42, add an event tag using the Wizard by clicking 
either the Wizard link in the What would you 
like to do? section or the  icon next to the Add 
button at the top. 

 

or 
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The Create New MetaData Event Tag screen 
displays. 

NOTICE 
In the following examples, Editor screen shots are 
used instead of the Wizard for simplicity purposes. 
The Wizard works in much the same way as the 
Editor, except that the Wizard screens are broken 
down into steps. However, all options are identical.  

 

5.4.1 Pre-Defined Event Tag Templates 
Whether using the Editor or the Wizard, the Pre-
defined event tag templates provide some of the 
most common prompts and tag answers without 
having to enter them manually.  

Click the Pre-defined event tag templates link. 
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The Add New Event Tags from Templates screen displays. 

 

NOTICE 
A maximum of 6 event tags can be configured, 
either all at once, or one at a time. However, to 
demonstrate the two types of event tags, two 
examples are provided: one for adding a Dropdown 
List event tag, and the second for adding a Text 
Field event tag.  

 

5.4.1.1 Adding a Pre-Defined Dropdown List Event Tag 

For this example, we are using Event Tag Template 
Item #1: Select an event category. This is a 
Dropdown List event tag, which allows the in-car 
officer to select from a list of answers when prompted 
with a question. 

From the Add New Event Tags from 
Templates screen, select the checkbox for Prompt 
#1 and click OK. 
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The Add New Tag screen displays. Because we 
have selected a pre-defined template, the Prompt 
and the Answers are already filled in for you. 

The  indicates the default answer for this event tag. 
To change the default answer, highlight the answer 
you want, and click the Set as default button. To 
clear the default value, click the Clear default 
button. 

A Metadata Field Name is already filled in for 
you. This field name identifies the event tag. You may 
change it if you want. 

 

NOTICE 
If you’re using or intend to use WatchGuard’s Video 
Evidence Library to manage your video storage, it is 
important to develop and use a consistent naming 
scheme for Metadata Field Names.  

 

The default In-Car Settings for this pre-defined 
Dropdown List event tag are: 
• Visible to the in-car officer – List fields are 

always visible, so this option is dimmed. Only text 
fields can be hidden. (See Creating a Non-
Editable Default Tag on page 52 for information 
on creating a hidden text field.) 

• Required – The in-car officer is required to enter 
an answer to the prompt. (See Making an Answer 
Required or Optional on page 52 for further 
details.) 

• Prompt not dismissed – The prompt remains on 
the DV-1 screen as long as it takes for the in-car 
officer to enter an answer. 

 

NOTICE 
The above In-Car Settings options are for this 
particular pre-defined event tag. Each pre-defined 
event tag may have its own default settings, and 
they are not necessarily the default when manually 
creating a new tag of that type.   
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For this example event tag, there are 9 possible 
answers already added for you. If you wish to add 
more answers to the list, click the Add button and 
input a new one. The maximum number of answers 
allowed is 15. 

Click OK when done. 

 
 

To edit an existing answer, highlight the answer and 
click the Edit button. Input the modification and click 
OK. 

To delete an answer, highlight it and click the Delete 
button, then click Yes to confirm. 

Click OK when done.  

5.4.1.2 Adding a Pre-Defined Text Field Event Tag 

For this example, we are using Event Tag Template 
Item #3: Enter ticket number:. This is a Text Field 
event tag, which allows the in-car officer to manually 
input the answer when prompted. 

From the Add New Event Tags from 
Templates screen, select the checkbox for Prompt 
#3 and click OK. 

 

The Add New Tag screen displays. Because we 
have selected a pre-defined template, the Prompt is 
already filled in for you. 

Alphanumeric is the default selection for the type 
of characters that the in-car officer can enter. Change 
to Numeric if applicable. 

If desired, enter a Default optional answer to be 
displayed for the in-car officer. This can save the in-
car officer some time if the answer is frequently going 
to be the same. The answer is editable by the in-car 
officer, if necessary. 

A Metadata Field Name is already filled in for 
you. This field name identifies the event tag. You may 
change it if you want.  
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NOTICE 
If you’re using or intend to use WatchGuard’s Video 
Evidence Library to manage your video storage, it is 
important to develop and use a consistent naming 
scheme for metadata field names.  

 

The default In-Car Settings for this pre-defined 
Text Field event tag are: 
• Visible to the in-car officer – The DV-1 will 

display the prompt to the in-car officer when the 
STOP/QUIT key is pressed. (See Creating a 
Non-Editable Default Tag on page 52 for 
information on creating a hidden text field.) 

• Optional – The in-car officer will not be required 
to enter an answer to the prompt. (See Making an 
Answer Required or Optional on page 52 for 
further details.) 

• Prompt is dismissed – When there is no 
response from the in-car officer after 30 seconds, 
the prompt is dismissed and the screen 
advances. 

Click OK when done. 

 

NOTICE 
The above In-Car Settings options are for this 
particular pre-defined event tag. Each pre-defined 
event tag may have its own default settings, and 
they are not necessarily the default when manually 
creating a new tag of that type.  

 

5.4.2 Manually Adding a Dropdown List Event Tag 
This section describes how to manually create a 
Dropdown List event tag. From the Create New 
MetaData Event Tag screen shown in Adding 
Event Tags on page 43, click the Selectable 
answers in a dropdown list link. 
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The Add New Tag screen displays. 

Type in the name of the prompt for the event tag. For 
this simple example, we have typed in What type 
of vehicle was the suspect driving? 

 

The default In-Car Settings for a Dropdown List 
event tag are: 
• Visible to the in-car officer – List fields are 

always visible, so this option is dimmed. Only text 
fields can be hidden. (See Creating a Non-
Editable Default Tag on page 52 for information 
on creating a hidden text field.) 

• Required – The in-car officer is required to enter 
an answer to the prompt. (See Making an Answer 
Required or Optional on page 52 for further 
details.) 

• Prompt not dismissed – The prompt remains on 
the DV-1 screen as long as it takes for the in-car 
officer to enter an answer. 

 

To add a list of answers that the in-car officer can 
choose from, click the Add button. Input the first 
answer and click OK. 

For this example, we are inputting SUV, Minivan, 
Pickup Truck, 2 Door Compact, and 4 Door 
Sedan. 

Continue adding answers in this manner. The 
maximum number of answers allowed is 15. 

 

To edit an existing answer, highlight the answer and 
click the Edit button. Input the modification and click 
OK. 

To delete an answer, highlight it and click the Delete 
button, then click Yes to confirm. 
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Once the above example answers are added, the 
screen will look like the one on the right. 

 

Enter a Metadata Field Name to identify the 
event tag.  

Click OK when done. 
 

NOTICE 
If you’re using or intend to use WatchGuard Video’s 
Evidence Library to manage your video storage, it is 
important to develop and use a consistent naming 
scheme for metadata field names.  

 

5.4.3 Manually Adding a Text Field Event Tag 
This section describes how to manually create a Text 
Field event tag. From the Create New MetaData 
Event Tag screen shown in Adding Event Tags on 
page 43, click the Text field answer link.  
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The Add New Tag screen displays. 

Type in the name of the prompt for the event tag. For 
this simple example, we have typed in What color 
shirt was the suspect wearing? 

Select Alphanumeric or Numeric to restrict the 
type of characters that the in-car officer can enter. 

If desired, enter a Default optional answer to be 
displayed for the in-car officer. This can save the in-
car officer some time if the answer is frequently going 
to be the same. The answer is editable by the in-car 
officer, if necessary.  

The default In-Car Settings for a Text Field event 
tag are: 
• Visible to the in-car officer – The DV-1 will 

display the prompt to the in-car officer when the 
STOP/QUIT key is pressed. (See Creating a 
Non-Editable Default Tag on page 52 for 
information on creating a hidden text field.) 

• Required – The in-car officer is required to enter 
an answer to the prompt. (See Making an Answer 
Required or Optional on page 52 for further 
details.) 

• Prompt not dismissed – The prompt remains on 
the DV-1 screen as long as it takes for the in-car 
officer to enter an answer. 

 

Enter a Metadata Field Name to identify the 
event tag.  

Click OK when done. 
 

NOTICE 
If you’re using or intend to use WatchGuard’s Video 
Evidence Library to manage your video storage, it is 
important to develop and use a consistent naming 
scheme for metadata field names.  
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5.4.4 Making an Answer Required or Optional 
To make the in-car officer’s response required, check 
the box Is answer required from officer when 
Record-Stop occurs?  

This also disables the timeout period from the 
Dismiss prompt automatically pull-down 
menu.  

To make the in-car officer’s response optional, 
uncheck the box Is answer required from 
officer when Record-Stop occurs?  

This also enables a timeout period to be configured 
from the Dismiss prompt automatically pull-
down menu. 

 

5.4.5 Creating a Non-Editable Default Tag 
When the Is tag visible to in-car officer? 
checkbox is not checked, the event tag will never be 
displayed to the in-car officer, and a static default 
answer will always be written to the DVD.  

This option can only be turned off for Text Field 
event tags. 

 

Select Alphanumeric or Numeric to restrict the 
type of characters that can be entered into the static 
answer box. 

Enter a Static answer value in the text box. This 
value will always be written to the DVD. 
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5.5 CHANGING THE ORDER OF EVENT TAGS 

When event tags are added, the Required tags 
automatically move to the top of the tag list since all 
Required tags must be presented to the in-car officer 
before Optional tags. 

If you want to change the order of the event tags, you 
may use the blue arrows on the right of the main 
event tag screen; however, you will receive an error 
message if you try to move an Optional tag above a 
Required. 

 

5.6 EDITING EVENT TAGS 
The steps for editing an event tag are very similar to 
adding them. Just as when adding event tags, you 
have the choice of using either the Wizard or the 
Editor. 

 

From the Event Tags Main Screen shown on page 
42, edit an event tag using the Editor by highlighting 
the event tag to edit and clicking either the Editor 
link in the What would you like to do? section or 
the Edit button at the top. 

 

or 
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From the Event Tags Main Screen shown on page 
42, edit an event tag using the Wizard by 
highlighting the event tag to edit and clicking either 
the Wizard link in the What would you like to 
do? section or the  icon next to the Edit button at 
the top. 

 

or 

 

NOTICE 
In the following example, Editor screen shots are 
used instead of the Wizard for simplicity purposes. 
The Wizard works in much the same way as the 
Editor, except that the Wizard screens are broken 
down into steps. However, all options are identical.  

 

For this example, we are editing the Dropdown List 
event tag with the prompt, What type of vehicle 
was the suspect driving?  We will add 
Limousine as a selection for the in-car officer. 

As described above, highlight the event tag you wish 
to edit, and click either the Edit button or the Editor 
link.  

The Metadata Event Tag Editor screen displays 
the event tag settings. 

Click the Add button. 
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Type in Limousine and click OK to add this as a 
choice. 

Continue making any other necessary changes to this 
event tag, and click OK when done. 

 

NOTICE 
Only one example of the editing capabilities has 
been shown because editing is very similar to 
adding an event tag. See Adding Event Tags on 
page 43 for further details.  
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6 Maintenance and Diagnostics 
6.1 MAINTENANCE AND DIAGNOSTICS OVERVIEW 
The FMU includes a Maintenance and Diagnostics 
mode for troubleshooting certain DV-1 scenarios. 
Under normal circumstances, most customers do not 
need to concern themselves with this functionality; 
however, if directed to do so by WatchGuard 
Customer Service, then a customer may be asked to 
run the Fleet Manager Utility in order to perform 
various maintenance and/or diagnostics tests. 

 

NOTICE 
The FMU’s Maintenance and Diagnostics mode 
requires that the computer and the DV-1 be 
connected via an Ethernet/network cable. 

See Ethernet Connection to the DV-1 on page 63 for 
information on how to make this connection.  

 

There are three major areas of information available 
in Maintenance and Diagnostics mode: 
• DV-1 system, software, and process information. 

(This information is of little interest to customers 
but can be of great use to WatchGuard Customer 
Service for troubleshooting purposes.) 

• A list of all the video files stored on the DV-1’s 
hard drive, allowing a customer to review the list 
and download selected video files to the PC 

• A list of all lost and found files stored on the  
DV-1’s hard drive 

 

6.2 DIAGNOSTIC SESSIONS 
Each time the FMU enters Maintenance and 
Diagnostics mode, it treats each occurrence as a 
diagnostic session and assigns a unique one-up 
number. Operators should be familiar with the current 
diagnostics session number each time they connect 
to a DV-1 in order to track certain noteworthy events 
and associate those events with that session number. 
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From the opening screen shown above, click the 
Maintenance and Diagnostics button. 

The Maintenance and Diagnostics screen displays. 

To start a new diagnostic session, click the Start 
New Session button. 
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A note informs the operator of a message that may 
show on the DV-1 screen. 

If desired, check the Don’t show me this 
message again checkbox so that this message 
won’t display again in the future. 

Click OK. 

If diagnostic sessions already exist, the screen will 
look something like the one shown on the right. 

To open an existing session, select the given session 
file from the list. The Open a previous 
diagnostic session in Read-Only mode… 
radio button is automatically selected for you.  

Click the Open Previous Session button. 

NOTICE 
To view a list of previous session files, click the 
Explore Session Folder link. From the resulting 
folder, delete unwanted session files as desired.   

6.3 DIAGNOSTIC SYSTEM INFORMATION 
When starting a new session, the Maintenance and 
Diagnostics screen displays, and the application 
automatically attempts to connect to the DV-1 to 
extract system information. 

Once the extraction of the information is complete, 
the Maintenance and Diagnostics screen will look 
something like the one shown below. 

The System Information tab contains technical 
details that would be of interest to WatchGuard 
Customer Service. Most notably, the list item entitled 
OS indicates what version of software is loaded and 
running within the DV-1. 

 



 

59 

 

6.4 DV-1 VIDEO FILES LIST 

Selecting the Video Files tab causes the 
application to retrieve the entire list of all the video 
files stored on the DV-1’s hard drive. Under normal 
circumstances and when a DV-1 is full, we would 
expect to see anywhere between 3000 and 5000 
video files in the list returned to the application by the 
DV-1. 

NOTICE 
Downloading the list of all 5,000 files is a time-
consuming process that normally takes 2 to 4 
minutes. The operator can cancel this operation in 
the middle of the process of downloading the list of 
all video files.  
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Once the list of video files has been downloaded, the Video Files tab will look similar to the screen shown below. 

 

The list of video files may be sorted by any displayed 
column by clicking on the column header. For 
example, to sort by Video Start Time, click on the 
Video Start Time column header cell. 

 

6.5 DOWNLOADING VIDEO FILES FROM THE DV-1 
One or more of the video files in the list can be 
downloaded from the DV-1 to the local computer by 
checking the checkbox to the left of the Video File 
name, and then clicking the Download Files button 
at the top of the screen. 

The figure on the right shows the first two video files 
with two of the checkboxes selected. 

By default, the list is sorted chronologically by the 
Video Files column, making the list items at the top 
the oldest files in existence on the DV-1. The DV-1 is 
always capturing video and caching it to the hard 
drive. Even while the FMU is in Maintenance and 
Diagnostics mode, the DV-1 continues to write new 
files to the disk.  
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NOTICE 
If the hard drive becomes full, the DV-1 begins to 
continually delete the oldest files to make room for 
the new files that have just arrived and are being 
written to disk. It is always possible to be viewing 
some of the oldest files in the list and those files 
might be removed by the DV-1 just after the FMU 
has retrieved their file names. In this case, trying 
to download such a recently deleted file will fail 
with an error message since the file no longer 
exists.  

 

Once the video files have been downloaded to the 
computer, the file list refreshes. A new  icon 
displays next to the video file name, indicating that a 
download has occurred. 

 

The Download complete! screen displays. 

Click Open Download Folder to navigate to the 
location of the downloaded video file(s), or click 
Close to simply exit the screen. 

The default pathname for the download folder is: 
C:\Documents and Settings\<YourUserName>\ 

My Documents\WatchGuardVideo\Fleet Manager 

Utility Program\Diags\DownloadFolder_VideoData 
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To navigate to the download folder at a later time, 
select Tools > Open download folder… 

Once the folder is opened in Windows Explorer, 
unwanted video files can be deleted as desired. 

 

6.6 DV-1 LOST & FOUND FILES LIST 

The content and operation of the Lost & Found 
Files tab works in much the same way as the video 
files content. Selecting this tab automatically causes 
the application to communicate with the DV-1 and 
starts the download of the files list that the DV-1’s 
operating system has marked as lost and found. 
Downloading the list of lost and found files from the 
DV-1 may take 2 to 4 minutes to complete. 

The lost and found files can be downloaded from the 
DV-1 to the computer’s hard drive in the same 
manner as was previously described when trying to 
download the video files. The lost and found files will 
likely only be needed when the customer is being 
directed and helped by WatchGuard Customer 
Service. 

 

 

 

 



 

63 

7 Ethernet Connection to the DV-1 
7.1 IS ETHERNET CONNECTIVITY TO THE DV-1 

REQUIRED? 
Two possible reasons for needing to connect to 
the DV-1 through an Ethernet cable are: 
1. Uploading configuration settings directly from 

the FMU to the DV-1 (bypassing the need to 
burn a configuration file to a CD) 

2. Running DV-1 Maintenance and Diagnostics 
from the FMU (see page 56) 

 

7.2 DV-1 ETHERNET/NETWORK CONNECTION PORTS 

7.2.1 Overhead DV-1 Ethernet Connection 

On the overhead DV-1, the Ethernet connection is 
on the side of the unit. 

 

7.2.2 Modular DV-1 Ethernet Connection 

On the modular DV-1, the Ethernet connection is 
on the back of the unit. Plug one end of the 
supplied Ethernet cable into the modular unit’s 
Network port and the other end into the 
Network/Ethernet port on the PC. 

WARNING! 
Do not mistakenly plug the Ethernet cable into 
the Wireless Microphone port or the 
computer’s Ethernet port could become 
damaged.  

 

Figure 1 Modular DV-1 Recording Unit Connections 
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7.3 DV-1 CONNECTION METHODS 
There are 2 different ways to connect the DV-1 to 
a computer: 
3. DV-1 to a Local Area Network (LAN) via a 

network router hub (which enables network 
access to the DV-1) 

4. DV-1 directly to a computer 

Option #1 requires a regular Ethernet network 
cable. Option #2 requires an Ethernet CAT 5 (or 
higher) crossover cable (a regular Ethernet cable 
will not work).  

If you have an IT Department, they may be able 
to supply you with a crossover cable, otherwise 
they should be available at any local electronics 
or computer store. 

 

7.4 COMPUTER NETWORK CONNECTION SETTINGS 
In order to connect to the DV-1 via an Ethernet 
connection, the computer’s network connection 
settings may need to be modified. 

 

7.4.1 Changing Network Connection Settings 
This section describes how to change the IP 
connection settings on your PC (or laptop 
computer) so that the FMU can properly 
communicate with the DV-1 system. 

First, physically disconnect your computer from 
the Local Area Network (LAN) by unplugging the 
network cable from the port on the computer. 
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Select Start > Control Panel. 

 

From the Control Panel, double-click the 
Network Connections icon. 

 

The Network Connections screen displays. 

Double-click the Local Area Connection 
icon. 

 



 

66 

The Local Area Connection Properties screen 
displays. 

Double-click Internet Protocol (TCP/IP). 

 

The Internet Protocol (TCP/IP) Properties 
screen displays. 

Change the radio button selection from Obtain 
an IP address automatically to Use the 
following IP address. 
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If the DV-1’s IP address is 192.168.0.123,  
then enter the IP address, Subnet mask, and 
Default gateway as shown in the screen on 
the right.  

If the DV-1’s IP address is 192.168.100.123, 
then enter 192.168.100.123 as the Default 
gateway and 192.168.100.124 as the IP 
address. 

When a three (3)-digit number is entered, the 
cursor automatically shifts to the next field. When 
you enter a single-digit number such as (0), you 
can shift to the next field with the [Right Arrow] 
key. 

Click OK when done. 

The screen closes and returns to the Local Area 
Connection Properties screen. Click OK again. 
The IP address on the computer is now changed. 

Reconnect the Ethernet cable to the computer. 

The FMU should now be able to communicate 
with the WatchGuard Video DV-1.  

7.4.2 Restoring Network Connection Settings 
When finished using the FMU to communicate 
with the DV-1 via the Ethernet connection, 
change the network connection setting back to 
Obtain an IP address automatically. If this 
original setting is not restored, the computer’s 
internet connection may not work properly after 
physically reconnecting it to the LAN. 

See Changing Network Connection Settings on 
page 64 for steps to access the network 
connection settings. 
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7.5 CONNECTION SETTINGS INSIDE THE FLEET 
MANAGER UTILITY 

The DV-1 device is shipped from the factory with 
one of the following default assigned IP 
addresses: 
• 192.168.0.123 – Existing systems 
• 192.168.100.123 – New or refurbished 

systems 

The FMU expects to find the DV-1 device at one 
of these locations; therefore, in most cases, these 
values do not need to be changed in order to 
connect to the DV-1 device. The default IP 
address displays on the FMU’s opening screen 
next to the DV-1 Connection Settings link in 
the lower right-hand corner of the screen.  

To change the IP address setting, click the DV-1 
Connection Settings link from the opening 
screen, or  select Tools > Settings. (Tip: the 
F2 hotkey is a shortcut to the Settings screen.) 

 

 

The Settings screen displays. 

To check whether the current IP address can 
successfully connect to the DV-1, click the Test 
IP Address button. This tests both the physical 
and logical connection between the FMU and the 
DV-1. If the DV-1 is unable to connect at 
192.168.0.123, try 192.168.100.123. 

If the DV-1’s IP address is not found, run the 
Auto-detect DV-1… function to find all DV-1 
devices available on the network. If the DV-1 is 
still not found on the network, even when doing 
an auto-detect, it may be necessary to manually 
enter an IP address on the DV-1 itself. For 
information on how to do this, see the DV-1 User 
Manual’s Network Configuration section. 

Once the IP address settings are correct, click 
Save to return to the previous screen. 
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